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Definizione di GIS –1
GIS: Geographical Information System  

SIT:Sistema Informativo Territoriale

Sistema che consente di memorizzare, visualizzare e analizzare in modo congiunto dati

geografici e alfanumerici. In particolare: visualizzazione, in varie forme, modifica,

creazione nuovi dati, interrogazioni integrate, analisi.

Esempio di interrogazione integrata: trova tutte le persone che hanno meno di 14 anni

(alfanumerico) e che abitano in un raggio di 1000 m da un certo impianto industriale

(geografico)



Definizione di GIS –2

Fino a pochi decenni fa informazione geografica e alfanumerica erano pressoché scisse:

esistevano da una parte le carte, disegnate e bidimensionali , e dall’altra gli archivi, per

esempio l’Anagrafe, pure informa cartacea.

Laseparazione era dovuta amotivi pratici e non concettuali.

Se la carta di una città riporta i numeri civici (la carta al 1:500 lo fa) e gli archivi anagrafici

riportano per ogni residente il numero civico di residenza, allora, in termini concettuali,

è possibile

 individuare sulla carta l’edificio in cui risiedeuna persona

 individuare tutte le persone che risiedono in un certo edificio

La cosa non è agevole per motivi pratici, perché richiede, ad esempio, di sfogliare grandi

registri per individuare tutte le persone che abitano ad un certo numero civico.



Definizione di GIS –3

Se la carta è digitale e vettoriale, se l’Anagrafe è stata resa digitale e sono state create le

opportune relazioni fra le diverse fonti di informazione, allora è possibile e

semplicissimo

 cliccare su una casa e vedere l’elenco delle persone che vi abitano

 individuare una persona nell’elenco dei residenti e chiedere al sistema di evidenziare

l’edificio in cuiabita.



Definizione di GIS –4
Bisogna distinguere fra:

 Sistemi Informativi Territoriali, intesi come singole istanze del concetto diSIT.  

Esempio: il complesso di hardware, software e dati che costituiscono il sistema

informativo territoriale di un Comune

 Programmi software per la gestione dei SIT: gli strumenti con cui sicostruisce un SIT

Si dovrebbe distinguere:

 GIS

 software GIS





Che cos’è un GIS oggi

Insiemi di dati complessi  

(Geodata)

Funzioni per la loro

visualizzazione e modifica  

(geovisualization)

Funzioni di analisi (Geo-

processing)



Che cos’è un GIS oggi - 2

Grande varietà di dati  

caricabili nei layer



Cartografia vettoriale

Gli oggetti presenti in  

cartografia sono rap-

presentati dapoligoni  

di cui il sistema

memorizza le 

coordinate  dei vertici



Oggetti raster
Immagini

 Dasatellite

 Daaereo

 Daterra



Oggetti raster - 2

Modelli digitali delterreno



Modelli digitali del terreno
La ricostruzione per via analitica della forma del terreno apartire dalla conoscenzadi un

numero adeguato di punti quotatisparsi.

Serve, in senso stretto, a conoscere la quota del terreno inogni punto.



Tabelle associate

Associazione fra  

edifici eabitanti



Dati 3D - 1

Cartografia vector 3D: analoga

alla modellazione solida  in un

CAD



Dati 3D - 2

Una carta spalmata

su un DTM



Modelli digitali del terreno vestiti

Una sorta di plasticovirtuale



Modelli 3D, tabelle, immagini





Quando si usa un GIS

In tutti i casi in cui i dati o una loro parte hanno una referenza spaziale

• Gestione del territorio da parte degliEnti

• Urbanistica

• Reti tecnologiche del sottosuolo

• Epidemiologia

• Sismologia

• Turismo

• Problemi Ambientali



I programmi GIS oggi
Un esempio di GIS commerciale: ArcGIS  

Un esempio di GISopen source:QGIS





La cartografia tradizionale, a supportocartaceo
E’ disegnata su un foglio di carta, che ne costituisce il supporto: supporto cartaceo. 

Il supportoè:

 bidimensionale

 limitato

 deformabile.



La scala della carta
Consideriamo un certo particolare, ad esempio il lato di un edificio rappresentato su una

cartografia.

Misuriamo la lunghezza del particolare sulla carta d c . Misuriamo la

lunghezza dello stesso particolare sul terreno d t .

Ledue misure non coincidono e sono in unrapporto
c

1
=

d

n d t

detto rapportodi scala; il denominatore è detto fattoredi scala.

In una carta il  rapporto di scala è lo stesso per tutti gli oggetti rappresentati.

In cartografia si ha sempre, ovviamente, 1/n < 1, cioè n > 1, in quanto la

rappresentazione cartografica ha una estensione minore della realtà.

Esistono ambiti applicativi, come la meccanica, in cui è utile talvolta avere rapporti di 

scala maggiori di1.



Qualità delle carte

La qualità (termine generale) delle carte è collegata a due parametri principali:

 l’accuratezza con cui restituisce le coordinate dei punti

 il grado di dettaglio con cui descrive il contenuto informativo: vengono indicati i

lampioni o no; le forme minute degli edifici vengono riportate o no.



Accuratezza delle carte
Accuratezza della carta: accuratezza con cui si possono fare sulla carta misure di coordinate,

distanza, area.

L’accuratezza è influenzata da due parametri principali:

 la precisione delle misure usate per costruire la carta, cioè la precisione delle

coordinate misurate e poi inserite nellacarta

 la precisione con cui la carta restituisce le coordinate; per leggere le coordinate da una

mappa cartacea (paper map) ci serve un righello oppure un tavolo digitalizzatore,

oppure una versione raster ottenuta per scansione



Lo spessore delle linee

Si  ritiene

convenzionalmente 

che le linee  con cui 

la mappa è  costruita 

abbianouno  spessore 

di 0,2mm.

Tale spessore limita

la  precisione con cui 

si  fanno misure di 

coordinate sulla

mappa



Errore di graficismo

L'errore di graficismo è l'errore ineliminabile con cui si misurano le coordinate sulla

mappa, dovuto allo spessoredel trattografico.

Errore di  

graficismo [m]

Fattore di  

scala della  

carta

Errore al suolo  

[m]

0,0002 500 0,10

1000 0,20

2000 0,40

5000 1,00

10000 2,00

25000 5,00

50000 10,00

100000 20,00

200000 40,00

L'errore di graficismo è l'errore

ineliminabile con cui si misurano le 

coordinate sulla mappa, dovuto allo

spessore  del tratto grafico.

L'errore di graficismo determina un

errore al suolo, che è funzione della

scala della carta



La classificazione delleentità

Tratteggi e simboli vari:

dicono che cos'è

un'entità.

La  mappa non dà solo 

informazioni su 

posizione  e forma 

degli oggetti, ma  anche 

sulla loro natura.



La classificazione delle entità - 2

Nella carta disegnatavi

sono entità classificate  in 

modo esplicito ed altre in 

modo implicito:  

l'osservatore, ragionando, 

comprende di che  cosa si

tratta.

Come mai non tutte le

entità sono classificate in

modoesplicito?

Per la limitatezzadel  

supporto.



La classificazione delle entità - 3
Parte della legenda di unamappa

La classificazione ha natura grafica e non è esaustiva in quanto non è possibile

discriminare graficamente 300/400categorie



Il supporto di unacarta
E' il foglio sucui è disegnata. Essoè bidimensionale ed ha estensionelimitata.

Questo spiega come mai non sia possibile fare classificazione esplicita esaustiva.

Bisognerebbe scrivere accanto ad ogni entità la sua natura: casa, albero, edificio,

marciapiede, ecc.

Ma sul foglio non c'è abbastanza spazio: una tale carta sarebbe così piena di segni da

risultare illeggibile.

Ilsupporto cartaceo rende la carta deformabile nel tempo.

Una carta disegnata è anche difficilmente modificabile (aggiornamenti, correzione di

errori).



Le mappe e la terza dimensione

La bidimensionalità del foglio implica che la cartografia a supporto cartaceo dà una

descrizione bidimensionale del territorio.

Vengono tuttavia applicate tecniche per rendere in modo ragionevole la terza

dimensione:

 curve di livello

 punti quotati



Curve di livello

Il terreno viene tagliato con piani

orizzontali aventi quote prefissate: i

profili così formati sono le curve di li-

vello.

Lecurve sono costituite da punti alla

stessaquota.

Due curve non dovrebbero mai

toccarsi e tantomeno intrecciarsi.

Ci sono le curve di livello

direttrici principali e

secondarie.

E' detta equidistanza la differenza di

quota fra due curveadiacenti.



Punti quotati

Viene indicata la quota del terrenoin

corrispondenza di alcuni punti

detti punti quotati.

La quota viene memorizzata con un

testo.

A volte la posizione della quota è

indicata dal punto decimale.



Punti quotati - 2

Altre volte vi è un punto ad indicare la  

posizione della quota.

Da notare che i punti quotati vengono  

usati anche indicare l'altezza degli edifici: 

vedi punti quotati all'interno dei  

perimetri.



Carta disegnata e altimetria

L'equidistanza delle curve e la densità dei punti quotati vengono scelti come

compromesso fra il dettaglio dell'altimetria e la leggibilità.

Come mai non si scrive la quota accanto a tutti i punti che costituiscono la carta? Per il

solito motivo dileggibilità.



Sommario della cartografia a supporto cartaceo
 Ha supporto bidimensionale, deformabile e limitato

 E' statica

 Caratterizzata da una scala

 Ha una precisione intrinseca che non è superabile

 La  classificazione esplicita è limitata; per il resto serve la capacità  

interpretativa dell'osservatore

 L'altimetria è descritta in modo limitato

 Può essere piegata, bagnata, bruciacchiata

 Chiunque (quasi) la può leggere ed interpretare.

 Non sono necessari computer, prese elettriche, batterie

 Non ci sono problemi di formati



Carta tecnica e tematica

Le carte tecniche sono le tipiche carte topografiche aventi lo scopo di rappre-

sentare il territorio in modo generale.

Si trovano rappresentati in esse edifici, strade, corsi d’acqua, particolari del

terreno come scarpate e i rilievi, ferrovie, elettrodotti, eccetera.

Le carte tematiche hanno uno scopo molto più specifico, cioè rappresentare

l’andamento spaziale di un qualche fenomeno.

Si presentano generalmente come mappe contenenti zone omogenee differenziate

nella loro tipologia dal codice cromatico o dalla simbologia grafica.



Carta tecnica e tematica - 2
Esistono innumerevoli esempi di mappe tematiche: le carte geologiche, che indicano la

tipologia degli affioramenti; le mappe sull’uso del suolo, che scompongono il territorio in

aeree omogenee relative a: edificato civile, edificato industriale, strade (se la scala lo

consente), boschi, frutteti, coltivazioni varie, ecc.; mappe sulle etnie presenti in un

territorio.

ESEMPIO

E’ dunque possibile ricorrere a mappe tematiche per studiare innumerevoli fenomeni di

tipo idrogeologico, economico, agricolo, etnico-politico, ambientale, demografico, ecc.

Una mappa tematica viene generalmente realizzata aggiungendo uno strato a una carta

topografica esistente, eventualmente opportunamente semplificata; chi realizza una carta

tematica non ha in genere le competenze per realizzare una mappa ex-novo, ma si limita

ad usarne una esistente.



Carta tecnica e tematica - 3

Il rilevamento geologico sfrutta ad

esempio le carte topografiche in

modo sistematico in quanto il

rilevatore va sul terreno con una

mappa topografica sulla quale ha

applicato un foglio di carta lucida;

individuato un fenomeno di

interesse geologico, il rilevatore

cerca oggetti riconoscibili sulla carta

e sul terreno per inserire

correttamente in mappa il

fenomeno che ha individuato. Il

rilevatore geologico, pur non

essendo un cartografo, deve saper

leggere bene unacarta.





La cartografia numerica odigitale

La cartografia digitale è quella che vive dentro ai computer. 

Essapuò essere di  tipo vettoriale oraster.

La cartografia vettoriale è quella in cui le entità non sono rappresentate da

linee disegnate, ma dalle coordinate dei vertici che costituiscono lelinee.



Che cos'è la cartografia vettoriale

Gli oggetti presenti in

cartografia sonorappresentati

da poligoni di cui il sistema

memorizza le coordinate dei

vertici



Come si può creare una carta vettoriale
Da zero, misurando le coordinate (preferibilmente 3D) di tutti i punti necessari con i

metodi usuali (fotogrammetria in primis) e costruendo i poligoni dentro a un CADo un

GIS.

A partire da una carta disegnata esistente, con una operazione che si chiama digitalizzazione

o vettorializzazione. 

Essa consiste, concettualmente, nel misurare con il righello le coordinate dei punti

costituenti la carta disegnata e nel ricostruire i poligoni in un CADoGIS.

In pratica, invece del righello, si usa un tavolo digitalizzatore (soprattutto nel  passato) o 

una versione scansita, ma concettualmente è come usare il righello.



Funzionalità di visualizzazione e ricerca

 Può esser facilmente aggiornata

 Colorazione logica

 Ricerca di edifici che hanno  una 

superficie maggiore di una  soglia

 Ricerca degli edifici che si trovano a 

una distanza non maggiore da un 

impianto chimicoo  da un fiume



Collegamento fra dati geografici e dati alfanumerici

E   anche l'elenco di tuttiquelli che abitano in edifici prossimi a un sito 

pericoloso,  ecc.

Se viene creato un

sistema informativo

territoriale e si crea

l'associazione fra edifici

ed abitanti, si può

ottenere l'elenco delle

persone che abitano in

un certo edificio.



Un GIS in una pagina





QGIS -Accendere QGIS e creare il primo progetto

Click su Icona

La finestra di  

QGIS

Per avere dettagli sull'istallazione, Guida->Informazioni



Parti principali interfaccia

Interfaccia di  

QGIS



Proprietà Progetto

All’apertura, QGIS crea 

un progetto vuoto e senza 

nome.  Suggeriamo di 

fissare immediatamente 

alcuni parametri 

essenziali.

Progetto->Proprietà 

Progetto



Linguetta Generale
Scegliere il colore dello sfondo e

delle entità selezionate: click sul

colore. Per la selezione scegliere

rosso.

Scegliere modalità relativa (delle  varie 

risorse caricate, cartografia,  

immagini, tabelle, il programma  

deve memorizzare la path relativa o

assoluta?).

Scegliere Metri

Dopo le impostazioni premere

Apply.



Linguetta Sistema di Riferimento
La scelta del SR può essere fatta

 scorrendo il lungoelenco

 cercando per ID

 cercando per nome

UTM-WGS84, Fuso33N;

vedremo in seguito

EPSG: European Petroleum Survey

Group



Linguetta Sistema di Riferimento -2

Ricerca perNome

Cerca una stringa o una parte nel  

nome.

Esempio "wgs 84 / utm". E' case  

insensitive, ma attenzione agli  spazi.

Attivare Nome; inserire "wgs 84/   

utm"; Trova; click su slider per  

evidenziare; Apply



Salvare il Progetto - 1

Per memorizzare le

impostazioni bisogna salvare

il progetto

File->SalvaProgetto



Salvare il Progetto –2

Selezionare la DIR

\corso_QGIS\dati\---------

e scegliere NOME

Il programma crea il file

NOME.qgs

e da questo momento indica  il 

nome del progetto nella  barra 

del titolo





Caricare gli shape files da Menu
Layer->AggiungiVettore

Oppure CTRL-SHIFT+V

Oppure ancora  

Click sull'icona



Caricare file shape

Scegliere File

Navigare nel disco (sfoglia) 

per cercare il fileda  caricare



Caricare file shape - 2

Nella cartella CARTELLA,  

selezionareXXXX.shp.

Apri



Caricare file shape - 3

Il contenuto del file

viene presentato a

video

Il file vieneaggiunto

alla tabella dei  layer



Aggiungere altri dati

Caricare anche altri shape  

edifici_2  

unita_volumetriche_1  

unita_volumetriche_2

Selezioni multiple conCTRL



Aggiungere altri dati- 2

Caricare anche le shape  

edifici_2  

unita_volumetriche_1  

unita_volumetriche_2

Selezioni multiple conCTRL



Aggiungere altri dati - 3

Spegnere per ora tutto  

tranne Edifici_1, facendo  SX 

sul quadratino a sinistra  del 

nome del layer, in modo da 

rimuovere il segno di  spunta



Anticipazione: cambiare colore

Attivare Edifici_1 (clickSX)  

Click DX

Proprietà



Cambiare colore - 2

Attivare Edifici_1  

(click SX)

Click DX  

Proprietà

Stile  

Cambia



Cambiare colore - 3

Scegliere il colore desiderato  

selezionando uno dei predefiniti

a sinistra oppure uno  degli 

infiniti presenti nellatavola a

destra.

E' possibile specificare la co-

difica RGB oHSV



Cambiare colore - 4

Ricorda:  

Apply  

OK



Cambiare colore - 5

Il risultato

Salvare di nuovo il  

progetto





Navigazione sulla mappa
Zoom: ingrandisce

o  diminuisce la 

grandezzadegli 

oggetti  visualizzati

Pan: sposta la

finestra virtuale,

costituita dallo

schermo, sulla

cartografia

Pan: da 

panning,  

panoramica



Gli strumenti della barra Navigazione mappa



Comando Sposta mappa (Pan)

Click sulla

zona da

spostare e

trascinare

con tasto

sx del

mouse

premuto



Comando Ingrandisci (zoom) - 1

Due modalità

Modo 1: click nella finestra

grafica: immagine si 

ingrandisce di  uno step

prefissato;

Modo 2: zoom finestra; si

definisceuna finestra con il 

mouse e la  visualizzazione 

viene modificata  in modo 

che la zona selezionata  

occupi tutta la finestra 

grafica  (tenendo conto di 

entrambe le  dimensioni)



Comando Ingrandisci (zoom) - 2

Click su vertici alto-sinistra

della  finestra da selezionare

Pigiare e tenere premuto SX  

Trascinare fino al punto in

basso  a destra

Rilasciare; il sistema 

effettua lo  zoom



Comando Ingrandisci (zoom) - 3

Il risultato.

Per ritornare alla 

videata  precedente è 

possibile utilizzare il 

comando Ultimo

zoom.

Uso della rotella del  

mouse: zoom aventi e

indietro,

comodissimo.



Comando Rimpicciolisci (Unzoom)
Le solite due modalità  

Modo 1: click nella

finestra:

l’immagine si 

rimpicciolisce di  uno step

prefissato;

Modo 2: si definisce una

finestra con il mouse e il 

sistema  cambia il rapporto 

di zoom in  modo che quanto 

si trova in  tutta la finestra 

grafica, vadaa  finire nella 

regione selezionata;  poco

utile



Zoom completo

Il rapporto di

zoom viene

modificato in

modo che tutti

i dati del

progetto siano

mostrati a

video

Il risultato



Comando Sposta mappa (Pan)

Facciamo preliminarmente

Zoom finestra sulla zona 

del Castello

Click sulla mappa e 

trascinare  con tasto sx del 

mouse premuto

La finestra rappresentata

dallo schermo viene 

spostata sulla  carta, 

lasciando inalterato il  

rapporto di zoom



Anticipazione: che cos'è una selezione

Una selezione è un'operazione con cui si individuano alcuni

elementi fra la totalità di quelli presenti nel progetto, per poi fare

operazioni: cancellazione, memorizzazione in un nuovo file,

modifica,ecc.

Vi sono diverse modalità di selezione, sulla finestra grafica e sulla

tabella associata. Per il momento, consideriamo la sola modalità

seleziona elementi conun rettangolo



Seleziona finestra

Attivare lo strumento

Seleziona elementi 

con un  rettangolo

Selezionare una 

regione  rettangolare

Attivare Zoom alla

selezione



Seleziona finestra - 2

Il risultato



Zoom sul layer – 1

Caricare lo shape

alberi_2.shp



Zoom sul layer – 2

alberi_2 viene

caricato e

visualizzato

nella zonarossa

Viene aggiunto 

un  secondo

elemento  nella 

barra dei layer



Zoom sul layer – 3

Zoom su layer  

chiede al sistema di 

fare zoom  e pan in 

modo  che il

contenuto  di un 

layer occupi tutta 

la finestra grafica

Attivare il layer  

alberi_2

Click su icona



Zoom sul layer – 4

Il

risultato



Zoom aggiorna

Si usa quando occorre

fare un ridisegno della

finestra corrente



Rimuovere un layer dal progetto

DX su alberi_2  Rimuovi





Scala video – 1

Usiamo edifici_1 alla

massima estensione.

Il programma mostra il  

rapporto di scala fra la 

dimensione degli 

oggetti sul  video e 

nella realtà.

Provare a fare zoom 

interattivamente per 

vederegli  effetti.



Scala video - 2

Il riquadro della 

scala  può essere 

usato per  forzare la 

scala a un valore

prefissato.

Si scriva nel 

riquadro  5000 e poi 

invio, per esempio.



Scala video - 3

Il risultato



Il riquadro della coordinate

Il riquadro mostra le

coordinate  del cursore

Può essere usato per forzare

un PAN: si inseriscono le

coordinate nel riguadro e

INVIO

Il rapporto di zoom rimane

costante, ma la finestra si 

muove fino ad avere, al 

centro, le coordinate indicate





Preparazione

Accendiamo il solo 

edifici_2e  attiviamolo.

Concetto di layer attivo:

quello  il cui nome è 

evidenziato nel  pannello 

dei layer.

Il layer attivo è quello su 

cui avvengono le selezioni.



Apertura della tabella associata

In un GIS, ogni layer

cartografico ha

associatauna tabella

Per visualizzare la

tabella del layer

edifici_2, DX sul

nome del layer, Apri

tabella attributi



Tabella associata al layer

Le colonne si  

chiamano  campi 

e le righe record.

Il numero dei  

record coincide 

con quello  degli 

oggetti  grafici. Vi 

è  corrispondenza

biunivoca  fra 

oggetti e  record.



Tabella associata al layer - 2
La tabella associata

contiene in generale

informazioni

alfanumeriche relative

agli oggetti, per esempio:

 nome e cognome del

proprietario

 anno di costruzione

 perimetro

 area

 valore di mercato

In questo caso il

contenutoè più tecnico.



L'associazione oggetti-record - 1
Selezionare lo

strumento Seleziona

il singolo elemento

Click su un poligono:

il poligono viene

evidenziato

La riga

corrispondente nella

tabella viene

evidenziata

Deseleziona...



L'associazione oggetti-record - 2

Viceversa, si  

può fare click  

sull'intestazion

e  di un record 

e il  

corrispondente  

poligono viene  

evidenziato



L'associazione oggetti-record - 3

Attivare lo

strumento di

selezione

rettangolare

Selezionare diversi

elementi sulla

finestra grafica



L'associazione oggetti-record - 4

I corrispondenti

record  vengono 

evidenziati  nella 

tabella. 

Le righe  non sono 

consecutive,  

ovviamente.



L'associazione oggetti-record - 5

Per visualizzare solo  

quelli selezionati, si

attiva la modalità

Mostra solo i

selezionati



I tipi di campi
Per visualizzare le 

proprietà dei campi di 

unatabella,

DX->Proprietà->Campi

Voglio esempio con 3

tipi  di campi

Alias: si associa al 

campo  un nome 

diverso, per la

visualizzazione. Provare 

a  mettere un alias



Significato di lunghezza e precisione

Per i campi testo (string) lunghezza corrisponde al numero massimo di

caratteri  che può contenere

Per i numeri decimali, è definito solo lunghezza, corrispondente al 

numeromassimo delle cifre

Per i numeri reali (con la virgola), lunghezza è il numero totale delle

cifre, compreso il separatore decimale; precisione è il numero di cifre

dopo la virgola.

Un numero reale come 5048325.331 è una tipica coordinata Gauss-

Boaga, ha lunghezza 10 e precisione 3





Salvare il Progetto - 1

Per memorizzare le

impostazioni

bisogna salvare il

progetto

File->Salva Progetto



Salvare il Progetto – 2

Selezionare la DIR

\corso_QGIS\dati\modulo_1

e scegliere modulo_1a

Il programma crea il file

modulo_1a.qgs e da questo

momento indica il nome del

progetto nella barra del titolo



Che cos'è un progetto QGIS
E' una scatola che

contiene i file 

caricati, le  modalità 

di visualizzazione, ecc.

Ma attenzione: il file  

QGS non contiene i 

dati,  ma solo l'elenco 

dei dati, le modalità di 

visualizzazione, il SR, 

ecc ecc.  Si tratta di un 

file XML,  leggibile con 

un editor  di testo



Che cos'è un progetto QGIS - 2

Un'altra parte del file qgs, che elenca i layer del progetto.

XML: eXtensible Markup Language 

(http://it.wikipedia.org/wiki/XML): si tratta  di un meta-linguaggio

http://it.wikipedia.org/wiki/XML


A che cosa serve un progetto

Chiudiamo QGIS e 

riaccendiamolo

Apriamo il progetto

modulo_1a



A che cosa serve un progetto - 2

Il progetto

ricompare come 

l'avevamo  

lasciato:

layer

caricati  

ordine  

colore

layer

accesi/spenti



Se si vuole spostare un progetto
Non basta spostare il file qgs, ma il file con tutti i dati. Una strategia

ragionevole  Creare una dir radice, es.c:\gis\pgt_prova

Creare se necessario sotto-dir al suo interno, contenenti vari dati.

Esempio

c:\gis\pgt_prova\shape_cartografia

c:\gis\pgt_prova\ortofoto

c:\gis\pgt_prova\azzonamenti

c:\gis\pgt_prova\tabelle_indici

Scegliere la modalità relativa

Salvare il file del progetto nella dir radice

Per spostare, ad esempio in un altro computer, copiare la dir radice e

tutto il  suo contenuto. Alla riapertura del file QGS, tutto funzionerà

come prima.





Per conoscere la posizione di un file

Il pannello dei 

layer  riporta solo 

il nome  del file 

caricato. Come 

conoscere il path  

completo?

Layer->DX-

>Proprietà-

>Metadati



Strumento - i
Lo strumento

Informazioni

elementi consente  di 

interrogare i singoli  

oggetti e di 

visualizzare i  dati 

contenuti nel record  

associato.

Bisogna

preliminarmente

attivare il layer che si

vuole interrogare



Strumento - i - 2

Se il punto su cui si

clicca contiene due o 

più  oggetti, vengono

mostrate le 

informazioni relative 

ad entrambi



Misura di distanze

Attivare lo strumento Linea di

misura: pessima traduzione che

significa misura di linea

Fare click sui vertici di una 

spezzata  di cui si vogliono 

misurare i singoli lati. Per finire 

la spezzata,DX

In grigio: la spezzata

disegnata  dall'utente

Lo strumento riporta le misure

parziali e il totale



Misura di area

Si disegna un poligono 

di  cui il sistema 

fornisce l'area. 

DX per finire.





Il formato shape
Il formato shape per i dati GIS è proprietario, in quanto definito da 

ESRI, ma  pubblico, ed è diventato uno standard. 

Il documento 

http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf

spiega in dettaglio la struttura dei file.

Un primo aspetto significativo è che un oggetto shape è costituito 

da numerosi  file

http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf


Il formato shape - 1

Usiamo la 

funzione  

aggiungi vettore 

di  QGIS: essa 

ha una  

visualizzazione

logica per cui 

edifici_1.shp è 

un unico  

oggetto



Il formato shape - 2
Guardiamo la dir con 

Esplora Risorse

I file avente nome

Edifici_1 sono 

numerosi, 

differenziati

dall'estensione.

Attenzione a quando 

si  scambia uno

shape: bisogna

copiare tutti i file!



I vari file del formato shape

SHP Descrizione della geometria di ogni singola feature -
indispensabile

SHX File indice, indispensabile

DBF Tabella associata, indispensabile

SBN, SBX Spatial index, per accelerare la ricerca

PRJ Parametri relativi al SR e alla proiezione

LYR Riguarda la vestizione: colore, spessore linee, ecc



Le shape sono specializzate
Mentre i file DXF, per fare un esempio famosissimo, possono 

contenere punti,  linee, poligoni (chiusi), testi, oggetti 3D, ecc, 

così non è per le shape.

Un file shape 2D ordinario, quelli di cui parleremo, può essere di 3

tipi

 punti

 polilinee (linee spezzate aperte)

 poligoni (linee chiuse); un poligono è costituito dal contorno e 

dal suo interno.

La conversione di una DXF a shape produrrà in genere diversi

oggetti shape, corrispondenti ai poligoni, ai punti e alla linee

contenute nel file originario



Le shape sono specializzate - 2

Facciamo Nuovo
progetto

Carichiamo le shape

unita_volumetriche_1  

nodi_stradali_1  

assi_stradali_1



Le shape sono specializzate - 3
Le icone associate da QGIS

alle shape indicano che si

tratta rispettivamente di

 Poligoni

 Punti

 Polilinee



Le shape sono specializzate - 4

La stessa

informazione si 

può trovare  nei 

metadati; per as-

si_stradali_1 si 

ha ad  esempio





Che cosa si può modificare
• L'aspetto delle feature è completamente configurabile.

• Per le polilinee: spessore della linea, tipo del tratto,

colore

• Per i punti: colore, forma del simbolo, dimensione

• Per i poligoni: spessore e colore del bordo, colore del riempimento

L'aspetto può essere configurato in modo che tutti gli elementi di

un layer abbiano lo stesso aspetto (Simbolo singolo, da

Single symbol) oppure può essere differenziato in base al valore

di un campo della tabella associata



Modifica del bordi di un layer poligoni
Nel progetto

modulo_1a, 

lavorare su  

edifici_2

DX->Proprietà-

>Stile  Cambia 

(sotto il  

quadrato)  

Impostare colore 

del  bordo rosso, 

linea  

tratteggiata, 

spessore linea 1



Modifica del bordi di un layer poligoni - 2

Il 

risultato



Modifica aspetto features di punti - 1

Carichiamo e 

attiviamo tutti i file 

_2. Lavoriamo su 

alberi_2,  

rappresentati da 

cerchi dal bordo 

nero e  contenuto 

giallo.

Modifichiamo in 

modo  usare 

pentagoni con  

bordo rosso e 

contenuto verde, di 

dimensione doppia.



Modifica aspetto features di punti - 2

Seguendo la solita

procedura, si accede a 

una finestra che 

consente si scegliere i 

parametri indicati e  

diversi altri ancora



Modifica aspetto features di punti - 3

Il 

risultato



Modifica aspetto features di punti - 4

Selezionando

l’opzione 

Indicatore  SVG è 

possibile

associare al 

punto una  

immagine.

Vi è anche la 

possibilità di 

creare propri  

simboli e 

immagini.



Modifica di entità nella modalità unique values

E' spesso molto utile modificare l'aspetto della feature in

funzione del valore di un campo. Esempi:

 nell'unica shape puntuale vegetazione, vi sono pini, abeti e larici,

distinti da un apposto campo essenza. Si vuole che i punti

rappresentativi abbiano colori diversi

 la stessa shape poligonale edifici, contiene edifici d'abitazione,

edifici minori e industriali, distinti da un campo. Si vuole

differenziare il loro aspetto

La modalità unique values deve essere usata quando il campo-

pilota assume un numero limitato di valori ed è basata sull'idea

che esistono tante classi-colore quanti sono i valori assunti dal

campo-pilota.



Visualizzazione unique values per edifici_2

Conideriamo ad esempio 

la  shape edifici_2 la cui 

tabella ha  un campo 

EDIFC_TY che dice il  tipo 

di edificio



Visualizzazione unique values per edifici_2 - 2

I valori possibili e il loro significato



Visualizzazione unique values per edifici_2 - 3

Categorizzato

Scelta del campo-

pilota

Scelta della scala

colore

Classifica

OK



Visualizzazione unique values per edifici_2 - 4

Il risultato



Visualizzazione unique values per edifici_2 - 5

Diversi aspetti possono essere

modificati. Per esempio la 

legenda, costituita dalla terza 

colonna, può essere editata a 

mano, con doppio  click.

Anche il colore dei poligoni.



Visualizzazione unique values per edifici_2 - 6

Il risultato



Creare una nuova scala colori - 1

Scegliere “Nuova scala  di

colori”.



Creare una nuova scala colori - 2

Modificare i colori eintrodurre

una interruzione.



Creare una nuova scala colori - 3

Salvare la 

nuova scala  

con un

nome.



Visualizzazione delle feature in 

modalità interval o graduata

Edifici_2 ha un campo 

area,  che prende un 

numero di valori

virtualmente infinito

Per visualizzare gli edifici 

in  funzione della loro 

area,bisogna adottare una 

strategia a  intervalli



Visualizzazione graduata per edifici_2 - 1

Graduato  

Colonna  

Scala colori  

Classi: 8  

Modo

Classificazione

Apply

OK



Visualizzazione graduata per edifici_2 - 2

Risultato



Visualizzazione di alberi_2 – 1

Tabella di 

descrizione dei

valori del campo  

ALBERO_TY.

Associamo rosso, 

verde, giallo



Visualizzazione di alberi_2 – 2

Risultato



Visualizzazione in funzione della scala

Carichiamo e accendiamo i soli edifici_1 ealberi_1



Visualizzazione in funzione della scala - 2

A certi rapporti di scala, i

simboli degli alberi rendono

illeggibile la cartografia

Vi sono varie soluzioni:

 cambiare ordine

visualizzazione

 fare in modo che il sistema

visualizzi il layer alberi_1 

solo a  rapporti di scala 

superiori a  una certa 

soglia, per esempio>  

1/3000



Visualizzazione in funzione della scala - 3

I settaggi da compiere. 

Bisogna inserire i limiti 

del  fattore di scala. E' 

stato  messo 3001 in 

modo che alla scala 

1:3000 il layer siavisibile



Visualizzazione in funzione della scala - 4

Risultato.

Perscala  grande



Visualizzazione in funzione della scala - 5

Risultato.

Per scala piccola





Che cosa si intende per editing

Un GIS è soprattutto uno strumento per analisi e interrogazione di

banche dati esistenti. Molti programmi GIS, e QGIS fra questi, hanno

funzionalità per lacreazione e la modifica dei dati.

Per la parte geometrica

 importazione di file DXF

 importazione di file di testopuntuali

 creazione di nuovi shape puntuali epoligonali

 aggiunta o cancellazione di poligoni in layer esistenti

 modifica di poligoni edentità



Che cosa si intende per editing - 2

Per la parte tabellare

 creazione di campi

 cancellazione di campi

 modifica manuale del contenuto di campi

 campi calcolati





Creazione di uno shape di punti
Modulo_4a  

Progetto nuovo  

SR32632

Selezioni rosse

Attenzione a snap

Creare shape puntuale  

cabine telefoniche  

Campi

 id

 anno

 modello



Lo snap - 1
Se si vogliono misurare

distanze e aree fra 

punti esistenti su 

qualche layer e lo  si 

vuole fare esattamente,  

bisogna attivare lo 

snapping

Vi sono dei settaggi

generali

Impostazioni-opzioni-

Digitalizzazione-

snapping



Lo snap - 2

Bisogna settare 

la  tolleranza di

snapping; deve 

essere  diversa 

da 0 altrimenti

lo snapping  

non funziona



Lo snap - 3

Altri settaggi

riguardano i

layer  per cui 

si vuole  

attivare lo

snap

Impostazioni-

Opzioni di

snap



Lo snap - 4

Attivare lo snap mettendo come tolleranza 10 m  

Attivare il layer edifici_2 e portarlo in alto nel pannello

Attivare lo snap per quel layer

Fare misure di distanza e area



Inserimento di entità
Attivare editing  

Strumento Inserisci

punto  Click su 

finestra grafica

Si crea un nuovo 

punto e gli si assegna la

posizione

Il sistema propone di 

compilare

contestualmente la  

tabella, cosa che può

anche  essere fatta dopo

Mettere label con ID



Inserimento di entità - 2

Il risultato



Modifica delle entità
Le entità possono essere:

Cancellate: seleziona+cancella

Copiate: seleziona+copia+incolla

Spostate

Alla fine, salvare

Chi mi dà le posizioni?

Devo immaginare di avere una carta di sfondo o avere le coordinate dei
punti

Se vi vogliono aggiungere entità a un layer esistente: attivare editing e 

fare come prima





Creazione shape vuoti

Dal menu Layero

dall’icona in figura,  

si possono creare  

degli shapefile  nuovi



Creazione shape vuoti - 2

Una volta 

lanciato il  

comando viene

richiesta la 

definizione del 

sistema di 

riferimento del 

layer  shapefile 

che si va  a creare



Creazione shape vuoti - 3

Poi viene richiesto il tipo di layer e bisogna

inserire gli attributi di ogni campo si voglia

creare

Campi  

ID

Area  

Descrizione



Creazione shape vuoti - 4

Si inserisce il

nome  dello

shapefile

Area_edificata



Creazione shape vuoti - 5

A questo punto

viene creato lo  shapefile e lo 

sivede nella finestra  grafica 

dei layer



Inserimento nuovi oggetti

Dopo aver

creato  il layer

con

l’opzione

modifica  si 

possono creare  

le nuove entità



Inserimento nuovi oggetti

Dopo aver attivato

l’opzionemodifica

si attiva la  barra di 

digitalizzazione che

permette

inizialmente la 

creazione, lo  

spostamento e la  

modifica di una  

entità



Inserimento nuovi oggetti

Per inserire

vertici,  SX

Sull'ultimi,

per  

chiudere, DX



Inserimento nuovi oggetti

Dopo aver premuto

ok l’entità viene

visualizzata con il

colore del layer



Modifica oggetti

Per modificare le

entità ci si

posizione sul 

layer si attiva

Modifica e si

preme  

Strumento

vertici



Modifica oggetti

Si clicca con il tasto  

sinistro del mouse  sul 

punto da modificare e 

tenendo  premuto lo si

trascina sulla nuova  

posizione e si rilascia il 

tasto del  mouse



Modifica oggetti

Per inserire un  

nuovo vertice ci si  

posiziona su un 

lato del poligono e

si  fa doppio clic 

conil  tasto 

sinistro del  mouse 

e viene creato un 

nuovo punto.



Modifica oggetti

Per cancellare un  punto 

di una entità  ci si 

posiziona conil  mouse 

sul punto, si  clicca con il 

tasto  sinistro del mouse  

in modo si evidenzi  con 

altro colore,  poi si 

preme Canc  sulla tastiera



Modifica oggetti

Viene visualizzata

l’entità modificata.

Una volta effettuate 

tutte le operazioni, 

si salva e si  chiude la 

funzione  modifica.

Anche i poligoni possono essere spostati, cancellati ecopiati.


